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Customize your toolbars, by Dick Schultz 
 

When doing word processing or spread sheeting with common programs such as MS WORD, MS EXCEL, Wordperfect or 
others, you can many times set up shortcuts on a toolbar near the top of your window.  Many packages come with pre-set 
toolbars but most allow you to also customize toolbars. 
 

Very simple programs like Windows Notepad do not allow toolbars.  Others like Windows Wordpad have just a few pre-set 
toolbars that you can turn on or off.  Sophisticated programs such as Word allow many different types of toolbars and in addi-
tion allow you to customize your own toolbars. 
 

Now why would a toolbar shortcut help you?  Take the case of making a title in a document have heavy type (Bold).  Without 
toolbars, you would have to highlight the title, select Format from the File Menu, select Font from the Format Menu and then 
click the entry marked Bold face, then click OK.  With Toolbars you would highlight the title and then click on the Bold sym-
bol in the toolbar. 
 

So, come to the April meeting and find out from Dick Schultz how to make your own toolbars. 
 
 How to Make Calendars,  by Linda Todd 
 

I use a 12-month calendar to stay organized! I wear many different hats, and without this wonderful tool . . . I would probably 
show up at the wrong place at the wrong time! 
 

During my 20-minute presentation at the April meeting, I will show you how to create calendars using both Word and Pub-
lisher. There are advantages to the calendar feature in each of these programs, but these days I prefer using Publisher. You 
will receive a handout so that you can go home and create a calendar which you can either use on your computer or print it. 
 
 
 

 

Problems in the Question and Answer SessionsS 

AA continuing problem in our general meetings is the variable quality of sound. This is serious for the presentations, but can 
be disastrous for the Question and Answer sessions.  Even if  the sound is not perfect for some of us during presentations, it is 
usually better than not using any amplifying system at all. That is simply because the natural voice of a great many  members 
is not nearly adequate for the size room we use. (Jerry  Gillette is a notable exception.) Consequently, many questions are not 
heard by any members except those in the immediate vicinity of the person asking the question. Unfortunately, numerous 
people asking questions virtually refuse to use the microphone offered to them.  As a result, there are times that most of us 
listen to answers with only a vague idea of what was asked. In such incidents, much potentially valuable information is lost to 
the majority of members.  
 

Please use the microphone when asking questions. If  the microphone is not immediately available, simply wait for the short 
time it takes to get it to you. It seems to not have  occurred to many of us that questions and answers are not intended to be 
strictly personal but are for the potential benefit of everyone present and listening.   
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April 2007 
Sun Mon Tue Wed Thu Fri Sat 

1 2 3 4 5 6 7 

8 9 10 11 12 13 14 

15 16 17 18 19 20 21 

22 23 24 25 26 27 28 

29 30      

May 2007 
Sun Mon Tue Wed Thu Fri Sat 

  1 2 3 4 5 

6 7 8 9 10 11 12 

13 14 15 16 17 18 19 

20 21 22 23 24 25 26 

27 28 29 30 31   

BGAMUG General Meetings are on the 4th Tuesday 
of each month.  The next two meetings are  April 24 
and May 22.  These meetings will be at the Bowling 
Green Technical College, Bld 5, at 6:30 PM.   See the 
map above.  Entrance to the BGTC campus on Loop 
Drive is clearly marked.  Building 5 is the last building 
on the left, down the road through the campus. Follow-
ing the meeting, there is a optional social meeting at 
Hardee’s Restaurant at Russellville  Road and Campbell 
Lane. Ask for explicit directions at the meeting. 
BGAMUG Board Meetings are on the first Tuesday 
of each month. The next board meeting will be on  
May 1 in the Alamo Room of the Lone Star Restaurant,  
2425 Scottsville Road. It is located between the Green-
wood Mall and the Best Buy store.  The meeting starts 
at 6:30 PM and is open to all. An optional dinner  at 
your own expense starts at the same place at 5:30 PM. 
The regular Lone Star Dinner Menu is available.  

Treasurer’s Report for April  By Jerry Gillette 

During March we were fortunate to receive special do-
nations from the APCUG Jerry Awards Community 
Service Contest, $250.00, and a generous $300.00 from 
the Cumberland View Towers for the efforts of the Non-
Profit Assistance SIG to boost our balance over the 
$3000 mark. All checks written for the month were for 
routine operating expenses. 

                                                     

BGAMUG’s Kroger Cares Gift Card  
                                        Fundraiser Program Update from Jerry Gillette 

                                                                    
Seven BGAMUG Members have reloaded their Kroger Cares Gift Cards during March for 
$1,175. That brings our total to $4,110 for the period. That means we only have $890 more to 
go before earning another 4% check from Kroger. 
 

All BGAMUG Members and supporters may participate in the Kroger Cares Gift Card Fund-
raiser Program by purchasing a Kroger Gift Card from the BGAMUG treasurer.  The cards  
cost $25 and come pre-loaded with $25 value. 
 

You may use the gift card for all your Kroger purchases at any Kroger store. You then visit any Kroger Customer Service 
Department and have the card recharged for any amount you choose.Each time members reload their cards, BGAMUG will 
receive 4% of the value.  When that total reaches $5000, BGAMUG receives a check from Kroger.  Keep up the good work.           

 

Balance March 1, 2007 $ 2,619.59 

March Deposits $  744.41 

March Checks $   218.52 

Balance March 30, 2007 $ 3,145.48 
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The Calculator with Extras 
By Carol Brodeur 

 

 I was recently looking through a copy of Smart Computing when I saw a free download for a calculator. Why would I need 
another calculator? I now use the one in Accessories. 
 

But as I read further, I found that this calculator had an 
added feature. It gave a running tape of your calcula-
tions. If you needed to retrieve a previous calculation it 
was right there just like a regular adding machine tape. 
If you have a long list of checks to add, you could go 
back and check that you had correctly entered all of 
them. For a forgetful senior citizen like me, this was a 
great advantage. The software is Moffsoft Free Calc, 
and can be obtained from the following web sight:                                                                                  
http://www.moffsoft.com/downloads.htm 
 

Go down to the second product, i.e., Moffsoft free calc 
and click on Moffsoft. Just follow the installation di-
rections which are quite simple. 
 

The illustration on the right shows the screen when 
using the calculator. In the open space to the right of 
the keyboard is the tape of entries and calculations. 
Actually, Moffsoft makes two calculators, the one de-
scribed is free, and the second (Microsoft Calculator 2) is available as a download for  $19.95, It is also available free for a 
thirty day trial.  A comparison chart on the Website shows that Calculator 2 includes financial functions (amortization sched-
ules,) units conversions, and a few other things that the free version does not. Neither version contains scientific functions.  

 

Review of Microsoft® Money 2007 for Home & Business 
By Jerry Gillette                

 
 

This review covers MS Money 2007,  Home & Business version. 
 

Having never used financial management software in my 20 years of using computers, this review will be more for the timid 
novice users than you savvy seasoned readers. 
 

Being elected as treasurer for our computer user group, I realized the need and was encouraged by fellow members to use a 
program like MS Money or Quicken. I chose MS Money mainly because it was so popular, used by the previous treasurer 
who produced some of the best ever reports and charts with Money, and Microsoft’s ongoing support for user groups. 
 

MS Money 2007 Home & Business installed in less than a minute. I was then prompted to download and install the updates. 
Next I obtained a Windows Live ID & Password to enable automatic access to our accounts online. 
 

Within minutes, following the simple instructions and the Online User Guide, I had both the clubs and our personal account 
information before me. I started balancing checkbooks and in no time I was tracking spending and creating charts and reports. 
 

I particularly appreciate the ability to customize spending categories and include data from split transactions. This is very im-
portant when writing reimbursement checks that cover member expenses for various categories. 
 

I look forward to using and reporting on more of MS Money Home & Business 2007 features in the months to come. 
 

MS Money Home & Business 2007 retails for $89.99, however, most retailers offer a $30 rebate that makes it only $59.99 
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As I write this article, it is week 14 of 2007 and today I delivered the 30th computer of  the year. It went to a cleaning lady 
who otherwise would never be able to afford one.  She has a grand daughter who will also use it “ after she  teaches grand-
mother how to use it” the lady says. 
 

At the current rate, the placements are averaging over two a week, which continues to amaze me.  It doesn’t seem possible 
that this rate of placement can be sustainable in the future ---- (PLEASE!) 
 

However, we have indeed averaged over 100 local placements per year for several years now, and that is very rewarding. I 
meet many hurting, deserving people and am fortunate to be able to assist them. It is amazing what a change a computer can 
make in a life. I am just thankful, that we can provide them through our computer club . 
 

Here is a  summary of where some of these computers  have gone in this past quarter. 
 

Jan. 20  To an adult in Morgantown who can’t read. Recommended by a Lifeskills caseworker who will supervise him. 
 

Jan 22   To Jasmine Clouse in Tompkinsville who, her teacher reported is learning motor skills and has improved greatly. 
 

Feb. 5   To Horse Cave for a fund raising auction. Sold for $260. 
 

Mar 8    To a Munfordville student to use in college. 
 

Mar 21  To an 80 year old B.G. man who said he wanted to “Keep up with his grandkids.” 
 

Two went to Bowling Green Lifeskills case workers for clients, and two went to Brownsville for Family Resource clients. 
 

The Saint Vincent De Paul thrift store continues to sell everything I take to them. I am providing mostly Pentium 3’s with 
monitors and Internet capabilities. They usually sell for $150 to $175 each.  
 

Again, thanks to all who made this possible. 
  
 
   

BGAMUG's Non-Profit Assistance Special Interest Group by Mike Moore 
 

Well, it is press time, and here I am again scrambling to fill a promised column.  We had a meeting 
on Thursday, April 12, at  5:30 PM in the Bluegrass Coffee house on Nashville Road. Next month, 
after officers approve the meeting minutes, I will give a report.  I do have some good news right 
now, which I have not yet shared with our primary non-profit.  A member of our group has arranged 
to place a brand new managed Cisco router into service at Big Brother Big Sister.  This router has 
the capability of designating specific network addresses on any given port, rather than relying on the 
router's DHCP service to assign port addresses.  This means that we can bring a specific network 
address to a given desk within the agency, allowing for a number of services that require a fixed IP 
address - not the least of which will be the Asterisk phone system.  Thanks to Cisco for the donation! 

 

Our Linux computer that will host the Asterisk telephone system for BBBS is here - although it's in pieces.  I hope to have it 
assembled in a week, at which time we'll install and configure the Fedora Linux operating system that I downloaded re-
cently.  The Fedora Core system comes on five completely full CD-ROMs including a restore disk.  I hope to have a DVD 
writer for this system as well to afford us the ability to back it up.  We are planning a "parallel" installation to make sure that 
the phone system works before placing it into service. 
 

Jerry Gillette e-mailed me today to let me know that two laser printers have been donated to Abel Court - I am sure these will 
be welcome there.  I've located and installed a network print server that was donated to the club on one of the existing laser 
printers at Abel Court.  This device places the printer directly on the network, which means that printing can be done without 
having to turn on a specific computer. 
 

The project in Madison, TN is almost ready to deploy and the seniors are anxiously awaiting their 
new computer lab.  At this time we have four computers built and I've asked Gene for a couple of 
Pentium III's in case the PCs I've already placed down there are too slow.  As soon as they clear out 
one of their rec rooms, we'll be ready to move in and hook everything up.  I have another donated 
laser printer in my car, thanks to Gene Iglehart. 
 

If you know of a deserving non-profit that needs help learning about or expanding their network, 
please let me know! Also, if you have special and useful computer skills, and would like to join this 
new special interest group, please contact me either at one of the meetings or by e-mail.  

PC Placement Quarterly Report  by Gene Iglehart 
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APCUG-member User Groups: You are receiving this discount offer as a benefit of your membership. Please forward it to 
your members as a benefit of membership in your group. I always substitute my computer club's name for APCUG in the 
statement at the bottom of this e-mail. 
  
Judy Taylour, Chair 
Member Services 
--------------------------------------------- 
 Dear User Group Member: 
 Alpha Software, one of the original software companies, has been developing database software as an independent software 
company for 25 years.  We have a customer base of over 1 million customers and have always worked closely with user 
groups. In fact, the original Boston Computer Society was where we got our start! 
  
To celebrate 25 years of building powerful, yet easy and productive database software, we would like to do something special 
for user group members. 
  
We have just launched Alpha Five Version 8 – which is the most exciting new product we have ever released.  
http://www.alphasoftware.com/AlphaFive/ProductTour/Features_00.asp   
  
In conjunction with our exhibiting at the upcoming SW Computer User Group Conference, we are making 1,000 copies avail-
able at very special pricing to User Group members to thank you for the role that User Groups have played in our history and 
growth. 
  
Alpha Five Version 8 is the first all-in-one solution that lets anyone build both web 2.0 and desktop database applications 
with full reporting, security and connectivity to any SQL backend or to the built-in Alpha database engine. 
  
Alpha Five Version 8 comes in three editions 
  
Desktop – SRP $199,   User Group Members Only Pricing  - $29.95 
(Builds Windows desktop single user applications) 
  
Professional – SRP $249   User Group Members Only Pricing  - $39.95 
(Builds Windows desktop multi user applications and web applications using Alpha Five’s DBF database engine) 
  
Enterprise -  SRP $349  User Group Members Only Pricing  - $49.95 
Builds Windows desktop multi user applications and web applications using Alpha Five’s DBF database engine or against 
any SQL database) 
  
To take advantage of this special opportunity: 
  
Please email marketing@alphasoftware.com  with the words Alpha User Group Special in the subject line (we will then get 
back to you with a secure ordering URL dedicated to this special “thank you to User Groups” offer). This offer is only valid 
for user groups.  We must have all the information shown below. 
  
Please sure to include: 
Full Name, Address, Telephone, Email Address, Street Address, City, State, ZIP, User Group Name, President's or Chair-
man's Name, 
 Please include which edition of Alpha Five Version 8 you want. 
 Hope to see you in San Diego! 
 Sincerely 
 Richard Rabins 
Co Chairman and Co Founder 
Alpha Software Inc. 
www.alphasoftware.com 
  
Note: APCUG does not endorse any company offering discounts, but makes these offers available simply as a service to our 
members. 

Discount Offer For APCUG Members (Including BGAMUG) 
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Wireless Networking Part III  by John Walker 
 

In this installment of the Wireless Networking Guide, we will discuss file sharing across the network. In this how-to I will 
assume that you have an existing network that is fully operational and communicating among the PCs you would like to share 
file with. 
 

First we need to ensure File Sharing is enabled and we need to make sure the firewall is disabled on your local area network 
device.  
 

Go to Start -> Control Panel -> and Network Connections. If you do not see Network Connections click on the link that says 
Switch to Classic View near the left of the window. 
 

Right click on Local Area Connection and Select Properties. Ensure that the File and Print Sharing is listed under the sub-
heading This connection uses the following items. If not you will need to perform the following steps to enable this function: 

From the General Tab, Click on the Install Button, 
 

 Click the Install button, Click once on Service to select that option. Click Add. 
 Click once on File and Printer Sharing for Microsoft Networks to select it and then click OK. 
 Click Close. 
 If the computer asks to restart, click No. You will restart your computer in the next step. 
 

Now click the Advanced Tab and Uncheck Protect my computer and network by limiting or preventing access to this com-
puter from the Internet and then press OK. Repeat this step on ALL PCs that you want to share files with on the network. 

 
Disable Simple File Sharing on Windows XP Pro  
 

If you have Windows XP Pro, follow these instructions to enable password-protected file sharing. If Simple File Sharing is 
not disabled, shared folders will not be password-protected - this will allow any users and network viruses easy access into 
your computer. If you have already disabled this feature on your computer, skip to the next section. 
 

1. Click on the Start button, then select the Control Panel.  
2. In the Control Panel window, double-click on Folder Options. If you do not see the Folder Options icon, click on 

Switch to Classic View located on the left side of the window to see all Control Panel options.  
3. Click the View tab.  
4. Uncheck Hide file extensions for known file types.  
5. Uncheck Use simple file sharing.  
6. Click Apply and then click OK.  
7. Close the Control Panel window. Proceed to      IV. Create user accounts.  

 
IV. Create user accounts 
 

A user account must be set up on the computer for each user or group of users who will have access to the shared folders. 
Any number of users within the Wellesley network may be allowed access your Windows 2000/XP Pro computer by adding 
them as users. You may create one user account on your computer for sharing purposes, i.e. you may give that account's user-
name and password out to anyone whom you allow to access shared folders. Or you may create multiple user accounts, one 
for each individual or group to whom you wish to give access to different share folders on your computer.  
 

Windows XP Pro 
1. Click on the Start button and select the Control Panel. Double-click on the User Accounts icon.  
2. Click on Create a new account.  
3. Type in a username for the new account, i.e. lilteapot. The name should not contain spaces or special characters. Do 

not use a domain account username.  
4. Click Next.  
5. Select Limited as the account type.  
6. Click on the Create Account button.  
7. Under the or pick an account to change section, click on the newly created account.  
8. Click on Create a password.  
9. Type a strong password for this user and then retype it in the next field to confirm it. You may skip the field for cre-

ating a password hint. Note: It is very important that you set a strong password for every user account.    
                                                                                                                                                                   Continued on  Page 9 
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 Countdown to the Digital Deadline 
By Jim Sanders, Editor, North Orange County Computer Club, California 

                                Reprinted with the author's permission through APCUG 
 

Television, as most of us know it, has barely two years of life left in it.  Congress has set a deadline of  
February 17, 2009 for analog broadcasts to end.  That means that the faithful television that you have  
had, for I don’t know how many years, will cease functioning on that date.  Well, cease functioning  
may be too strong of a description, but there will no longer be an over the air  broadcast of the analog  
type of signal that it knows how to interpret. 
 

Starting on that date, all of the over the air television broadcasting stations have been mandated to 
transmit the digital television format signal only.  Old faithful, or maybe not so old, can still be used as long as there is some 
device that can feed it the analog signal that it knows how to deal with.  This could be your VCR or DVD player for instance.  
Or, it could be one of the set top boxes that millions of people are going to have to purchase if they wish to continue using 
their analog television to receive over the air television broadcasts.  The purpose of the set top box is to tune in the digital 
television frequency and convert it to the NTSB analog signal that your television knows how to deal with. 
 

The set top boxes contain an ATSC tuner.  This stands for Advanced Television Systems Committee.  They are an interna-
tional organization setting the standards for digital television.  In time, they will replace the NTSC, which is an American or-
ganization overseeing analog TV transmissions.  There is considerable talk about Congress passing legislation to subsidize, or 
provide free of charge, set top boxes to low income families.  At this time there is no requirement that the recipients be United 
States citizens. 
 

When you purchase a digital television, ATSC is a term that will be listed on the specifications showing that the television 
has a built-in digital tuner.  There are eighteen formats in the DTV spectrum, 12 SDTV formats and 6 HDTV formats. 
 

The Federal Communications Commission (FCC) is the regulating organization in the United States that controls conversion 
from analog to digital.  The Federal Communications Commission has set deadlines that mandate all manufacturers include 
digital tuners in their televisions. These are the dates that have been mandated: 
 

July 1, 2005: all TVs with screen sizes over 36 in. must include built-in ATSC tuner. 
July 1, 2006: 100% of 25 to 35in. TVs must include ATSC DTV tuner. 
July 1, 2007: 100% of 13 to 24in. TVs must include ATSC DTV tuner. 
July 1, 2007 100% of all interface device’s must have ATSC DTV tuner.  That includes equipment such as VHS VCRs, DVD 
player/recorders, and DVRs. 
 
These deadlines only apply to new televisions and do not include the huge inventory of existing units.  That is why you may 
see a number of television’s larger than 36in. still being sold without built-in digital tuners. 
 

Definition of television; a television is a viewing device that includes a tuner.  A device without a tuner is called a monitor.  
There is a loophole in the FCC regulations that allows manufacturers to build TVs without any tuner which would technically 
make it a monitor. 
 

Most cable subscribers and all satellite subscribers use their service provider’s set top box to receive and decode the digital 
signals instead of using the television’s built-in ATSC tuner.  One exception to that rule is a small credit card type of chip that 
takes the place of the set top box and is called a CableCARD. 
 

Most cable and satellite providers charge in the neighborhood of $9.95 a month to receive HD channels. Over the air High 
Definition channels are “free” in the same sense that current analog channels are free, that is you pay the price of watching 
the commercials but don’t actually have to shell out money.  So if you spend the extra bucks up front to buy an HD television 
that includes the ATSC tuner, you are not forced to pay that additional monthly charge.  By purchasing an antenna from an 
electronics store for in the neighborhood of $25.00 to $100.00, a person that owns a set with a built-in ATSC tuner can enjoy 
the over the air broadcasts for free. 
 

When the analog signals are turned off and digital becomes the standard, cable and satellite providers will probably provide 
the local networks for free if they don’t do so already.  But you will still have to buy or lease the cable box which right now 
costs in the neighborhood of $199.00.  In addition to that, you’ll still have to purchase the programming from the provider. 
So if you are a person that currently relies on getting all of your television through a rooftop antenna, in less than two years 
you will be faced with the choice of spending money for some new equipment or no longer being able to watch television. 
 

One method of dealing with the problem would be to purchase one of the new DVD VCR combos that include the ATSC 
tuner. A number of VCR manufacturers, including Panasonic, have announced that when the regulations go into effect, they 
will simply stop manufacturing that class of equipment. JVC has announced a new DVD/VCR/ATSC  tuner model that will 
be available in May.  It is the DRMV99 selling for $329.95.                                                                    Continued on Page 8          
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If you already own a good VCR and a good DVD player, it might make more sense to go ahead and pur-
chase just the ATSC set top tuner.   
 

In addition to dealing with all of the high definition signal acquisition problems, a whole lot of people are 
already trying to deal with the somewhat confusing array of HDTV offerings.  The terminology which is 
frequently observed in the papers can be very confusing.  The phrase “HD ready” is usually an indicator that 
the unit is a monitor that does not include a tuner.  A lot of advertisements conveniently do not include what 
version of high definition a particular offering is.  It is simply referred to as HD without saying whether it is 

720i, 720p, 1080i or 1080p. The actual pixel resolution is often omitted as well.  The 720i or p sets need to have a resolution 
of 1280 pixels by 720 pixels.  The real 1080i or p sets need to have a resolution of 1920 pixels by 1080 pixels. Just like the 
older VGA computer monitors the 720i refers to an interlaced display and the 720p refers to a progressive scan display.  The 
progressive display is the better quality. 
 

Then you have to decide which display technology you are going to pick, the Plasma flat panel, the LCD flat panel, the rear 
projection DLP television, the rear projection LCD television, or the wall projection unit in either DLP or LCD.  What is the 
brightness level?  What is the viewing angle?  What is the life expectancy of the projector bulb?  What is the cost of the pro-
jector bulb?  Does the unit have a VGA, a DVI and an HDMI video connector? 
 

At the moment, I think the best bang for the buck is to purchase a projector that will do 720p, and if you can afford the extra 
cost, one that will do 1080p.  If you have never seen even an older 800x600 projector displaying a movie from a standard 
DVD on an eight foot diagonal screen, I think you will find it impressive and I think you should do that before you spend 
money on anything. 
 

Some useful FAQs are available on the Website  http://www.dtv.gov/  
 

What is the digital TV transition? 
The switch from analog TV (the traditional TV system using magnetic waves to transmit and display TV pictures and sound) 
to digital television (the new TV system using information transmit-ted as “data bits” -- like a computer -- to display movie-
quality pictures and sound), is referred to at the digital TV (DTV) transition. In 1996, the U.S. Congress authorized the distri-
bution of an additional broadcast channel to each TV broadcaster so that they could introduce DTV service while simultane-
ously continuing their analog TV broadcasts. In addition to improved picture and sound quality, an important benefit of DTV 
is that it will free up parts of the broadcast spectrum for public safety as well as other valuable uses. This is possible because 
the modern technology of DTV is more efficient than analog TV technology. DTV allows the same number of stations to 
broadcast using fewer total channels (less of the broadcast spectrum) which will free up scarce and valuable spectrum for 
public safety and new wireless services. 
 

What is the February 17th, 2009 DTV deadline date? 
Congress passed a law on February 1, 2006, setting a final deadline for the DTV transition of February 17, 2009. Most televi-
sion stations will continue broadcasting both analog and digital programming until February 17, 2009, when all analog broad-
casting will stop. Analog TVs receiving over-the-air pro-gramming will still work after that date, but owners of these TVs 
will need to buy converter boxes to change digital broadcasts into analog format. Converter boxes will be available from con-
sumer electronic products retailers at that time. Cable and satellite sub-scribers with analog TVs should contact their service 
providers about obtaining converter boxes for the DTV transition. 
 
What is digital television (DTV)? 
Digital television (DTV) is a new type of broadcasting technology that will transform television as we now know it. By trans-
mitting the information used to make a TV picture and sound as “data bits” (like a computer), a digital broadcaster can carry 
more information than is currently possible with analog broadcast technology. For example, the technology allows the trans-
mission of pictures with higher resolution for dramatically better picture and sound quality than currently available – called 
High Definition Television (HDTV) - or the transmission of several “standard definition” TV programs at once – called 
“multicasting.” “Standard definition” digital TV pictures would be similar in clarity and detail to the best TV pictures being 
received and displayed today using the current analog broadcast system and TV receivers. DTV technology can also be used 
to provide interactive video and data services that are not possible with “analog” technology.  
 
Is HDTV the same thing as DTV? 
HDTV is the highest quality of DTV, but it is only one of many formats. In addition to HDTV, the most common formats are 
Standard Definition Television (SDTV) and Enhanced Defini-tion Television (EDTV).   SDTV is the baseline display and 
resolution for both analog and digital. Transmission of SDTV may be in either the tradi-tional (4:3) or wide-screen (16:9) for-
mat. EDTV is a step up from Analog Television. EDTV comes in widescreen (16:9) or traditional (4:3) format and provides 
better picture quality than SDTV, but not as high as HDTV.  

Countdown to the Digital Deadline  Continued from page  7 
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Wireless Networking Part III  Continued from Page  6 

This will be the username and password necessary for 
access to shared folders.  

10  Click on the Create Password button.  
11 If you wish to create multiple user accounts, repeat 

steps 2-9 for each new account.  
12 When all users have been added, close all open win-

dows. Proceed to: 
           V. Setting up the folder that will be shared.  

 

V. Setting up the folder that will be shared  
 

Only folders may be shared, not individual files, i.e. if you 
wish to share a file named blue.doc, then you must put 
blue.doc inside a folder and then share that folder by follow-
ing the directions below. Note: If a Windows 98 computer is 
going to access your shared folder, then the name of your 
shared folder should not contain any spaces. 
 

1 Right-click on the file or folder to be shared. In the menu  
that appears, select Sharing or Sharing and Security 
 

                  
 

2. Select Share this folder. The name of the folder that ap-
pears on the network may be changed by typing in the new 
name in the Share name field.  
3. Click on Permissions.   
 

 
 

5  Click Add.  
6  To give user accounts access to this folder:  

In Windows 2000, make sure the Look in: bar has the name 
of your computer selected. Under the Name section of the 
Select Users or Groups window, double-click on the names 
of the user accounts that will have access to the folder. Click 
OK when you are done 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In Windows XP Pro: 
1.  In the Enter the object names to select field, type in the           
name of the first user account (or alternatively, type in the 
<ComputerName>\<user name of the account>) that will 
have access to the folder and then click Check Names.  

  
 2. To add multiple user accounts, type a semicolon after the 
first account name and then repeat step 1 for each account 
you wish to add.                                                                 
                                                                        Continued on Page 10 
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Each user account will appear as COMPUTER NAME\user name (i.e. johndesktop\john) and each user account will be 
separated by a semicolon.  
3.  Click OK when you are done.  

To change each user account's permissions, in the Permissions window for that folder, click once on the name of the user ac-
count. Once it is highlighted, you may allow or deny them privileges according to the options below. Check or uncheck the 
boxes next to the permissions you wish to give the user. Note: You must change the permissions for each user account that 
has access to this folder.  
•  Read allows the user to read the files in the folder.  
•  Change allows the user to add, alter, or delete files in the folder.  
•  Full Control allows the user to read, add, alter, and delete files in the folder as well as to adjust these permissions or take 

ownership of the folder.  
When the permissions for all users have been set, click OK.  
Click on the Security tab and then click Add. If you do not see a Security tab within the share folder's Properties window, 
then skip  to step 11. Add all the user accounts that you have added in the Permissions window above in step 6.  
 

In Windows 2000, in the top window, double-click on the names of the user accounts that will have access to the folder. 
Click OK when you are done.  
In Windows XP Pro:  

1. In the Enter the object names to select field, type in the name of the first user account that will have access to the 
folder and then click Check Names.  

2. To add multiple user accounts, tap the spacebar on the keyboard to put a space after the first account name and then 
repeat step 1 for each account you wish to add. Each user account will appear as COMPUTER NAME\user name (i.e. 
JohnDesktop\john) and the accounts will be separated by a semicolon. 

       3.   Click OK when you are done  

Click Apply and then click OK. The folder icon will change into a folder resting on an arm . This indicates that this 
folder is now shared. Anyone who knows the username and password of the account(s) set up with access to the shared folder
(s) will be able to access the folders, so be careful about giving out the account information and make sure the users whom 
know that information understand the importance of keeping them secure.  
1.  Find the computer where the shared folder resides.  
• In Windows 2000, double-click on My Network Places > Entire Network > entire contents > Microsoft Windows 

Network > YourNetwork  
• In Windows XP, click on the Start button and select My Computer. In the Other Places section on the left-hand side of 

the window, click on My Network Places. Under the Network Tasks section on the left side of the window, click on 
View workgroup computers.  

2 Double-click on the name of the computer the shared folder resides on.  
3 Double-click on the folder you have access to.  
4 In the window that appears, type in the username and password of the user account you have been given in order to ac-

cess that shared folder.  
5 Click OK.  

 
 
 
 
 
 
 
 

 
 
The folder's contents will now be displayed in a window. What you are allowed to do in this folder depends on the permis-
sions its owner has given you. 

Wireless Networking Part III  Continued from Page  9 
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BGAMUG Club News   
 
 

2007 Club Officers 

Birthdays in May 
 

              Edward W Adler Jr …………….15th 
              Romona Bobbitt  ……………….4th 
              Ward  Coleman ………………...22nd 
              Patricia Vincent ………………...12th 
              Carlisle Barnes ………………….17th 

President 
Michael Moore  843-9535 
ml.moore@insightbb.com 

Program Director 
Linda Todd  781-7872 
linda.todd@wku.edu 

VP of Membership 
Dick Schultz  393 0120 
dschul41@yahoo.com 

Webb Master 
Chuck Thomas 843-6380 
chuckt@insightbb.com 

Secretary 
Lou Travelsted  776-0649 
kymamalou@bellsouth.net 

VP of Protocol 
Gilbert  Lakes 202 0312 

gilbert.lakes@insightbb.com 

Treasurer and 
APCUP represenative 
Jerry Gillette 781-6309 
jagky@insightbb.com 

Newsletter Editor 
Carlisle Barnes 846 1515 

newcarlislebarnes@ 
insightbb.com 

Sergeant at Arms 
Raymond Hunton 781-2380 

rhunton@insightbb.com 
  

Librarian 
Karen Wickliff  842-2715 
kwickliff@bellsouth.net 

Officer At Large 
Carol Brodeur 749 3722 

ccbrodeur@windstream.net 
  

Officer at Large 
Pat Vincent 782 1191 
pat.vincent@wku.edu 

PC Placement Program 
Gene Iglehart  842-4570 

iglehart@aol.com 

BGAMUG Historian 
Ginny Molloy 846 7274 

charmcat@aol.com 

Spelling Errors. Unfortunately, at times there have  been spell-
ing errors in the newsletter.  Particularly serious are misspellings of 
members names. The  corrected spelling of  two of  these are: 
Wayne Gustafson and Dick Schultz.  Also, there have been some 
errors in birthdates and anniversary dates. (Thank Betty Lyne for 
noting these last month.) Hopefully current ones are correct.  

For Kroger Cares™ Information,  
contact Jerry Gillette at   

jagky@insightbb.com  781-6309 
 

For Fern Terrace Information,  
contact Raymond Hunton at   

rhunton@insightbb.com  781-2380      
 

 For Abel Court Information,  
contact Debbie Fugate at 

 aca0401@bellsouth.net   842-4114    

 Door prize for the April 24th BGAMUG Meeting is a 50 Piece Tool Kit  Anyone attending the meeting can win.  

                                                                                                                                                                                                                                                                                                                                                                                                                                            Continued  on Page 11 
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How to remove file sharing  
 

To un-share a particular folder: 
1. Right-click on the folder's icon. Select Sharing... or Sharing and Security..  
2. In the window that appears, select Do not share this folder.  
3. Click Apply and then click OK.  
 

To turn off file sharing completely: 
1.   Go to the Control Panel.  
• In Windows 2000, click on the Start button and then select Settings > Control Panel.  
• In Windows XP Pro, click on Start and select the Control Panel.  
2.  Double-click on the Network Dial-Up Connections or Network Connections icon.  
3.  Right-click on Local Area Connection and select Properties.  
4.  Select File and Printer Sharing for Microsoft Networks.  
5.  Click the Uninstall button.  
6,  Click Yes in the window that appears.  
7.  Click Close.  

       8.  Restart your computer 
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BGA-bytes is the monthly newsletter 
publication of the Bowling Green Area 
Microcomputer User Group, Inc. (BGAMUG), 
which is a nonprofit, charitable educational 
society recognized by the Internal Revenue 
Service as a 501(c)3 tax-exempt charitable 
organization.  Donations to BGAMUG may be 
tax-deductible. 

The views expressed in BGA-bytes are those 
of the author(s) and do not necessarily reflect 
the official views of the organization. 
BGAMUG is a member of the Association of 
PC User Groups (APCUG) membership. 

BGA-Bytes 
171 Stone Mill Court 

Bowling Green, KY 42122-9770 

BGAMUG

Don’t forget our April meeting at  
the B G Technical College, 

Building F, 
April 24, 6:30 PM. 

BGA-bytes is online, now in two formats to allow a choice between speed and better quality.   
If you have fast Internet service, or if you wish to print-out the newsletter with best quality, then access: 
 http://www.bgamug.org/newsletterarchives/mar2005-hi.pdf 
If you use the phone for dialup Internet service, and want to access the newsletter more rapidly, then access:  
 http://www.bgamug.org/nesletterarchives/mar2005-lo.pdf 
In either case, to see our online edition of the newsletter you will need Adobe Acrobat Reader installed on 
your computer. If you do not have it, then you need to download and install Acrobat Reader by accessing;    
 http://www.adobe.com/products/acrobat/readstep2.html 

BGAMUG holds regular presentation/membership 
meetings the fourth Tuesday of each month (except De-
cember) at the Bowling Green Technical College 
(BGTC) on Loop Drive in Bowling Green, Kentucky. 
The public is invited to attend our regular 
presentation meetings.  To join, our annual 
membership dues are $25 for an individual and $35 
for a family. Loop drive intersects Morgantown Road 
just West of  Warren Central High School. There is a 
stoplight at the intersection. The access road to BGTC 
from Loop is clearly marked with a sign. The meeting 
building is Building F in the last group of buildings 
down the access road. A map is inside this newsletter.   

For contact with BGAMUG not related 
to return mail for BGA-Bytes,  please 
use this mailing address: 
 
BGAMUG 
P.O. Box 50882 
Bowling Green, KY 42102-4182 


